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Abstract

BibleTime is a completely free Bible study program. The program's user interface is built with the Qt framework,
which makes it run on several operating systems including Linux, Windows, FreeBSD and Mac OS X. The software
uses the SWORD programming library to work with over 900 free Bible texts, commentaries, dictionaries and books
in over 50 languages provided by the Crosswire Bible Society and several other repositories.

Il Manuale di BibleTime è distribuito con il programma di studio di BibleTime.
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Chapter 1. Introduzione
About BibleTime

BibleTime è uno strumento di studio della Bibbia che supporta diversi tipi di testi e lingue. Anche
gradi quantità di documenti sono facili da installare e gestire. È costruito sulla libreria SWORD [http://
www.crosswire.org/sword], che fornisce un back-end per BibleTime, come ad esempio la visualizzazione
della Bibbia, le ricerche ecc. SWORD è il prodotto principale di Crosswire Bible Society [http://
www.crosswire.org].

BibleTime è fatto per essere usato con documenti codificati in uno dei formati supportati dal progetto
SWORD. Informazioni complete sui formati supportati possono essere trovate nella  sezione per
sviluppatori [http://www.crosswire.org/sword/develop/index.jsp] del Progetto SWORD, Crosswire Bible
Society.

Documenti disponibili
Over 280 documents in 50 languages are available from the Crosswire Bible Society [http://
www.crosswire.org]. These include:

Bibbie L'intero testo della Bibbia, con optional
come i numeri Strong, intestazioni e/o note
nel testo. Le Bibbie sono disponibili in
tante lingue, e includono non solo versioni
moderne, ma anche antichi testi come il
Codice di Leningrado ("WLC", Ebraico), e
la Septuaginta ("LXX", Grebo). Questa è
la sezione più avanzata nella libreria del
progetto SWORD.

Libri I libri disponibili includono "Imitation of
Christ", "Enuma Elish", and "Josephus: The
Complete Works" (in inglese)

Commenti I commenti disponibili includono classici
come "Note sulla Bibbia" di John Wesley, i
commenti di Matthew Henry e "Commento ai
Galati" di Lutero. Con i commenti Personali
puoi  salvare le tue note personali nelle
sezioni della Bibbia.

Letture di devozione giornaliere Molte persone apprezzano queste porzioni
giornaliere della Parola di Dio. I documenti
disponibili includono Daily Light sul Daily
Path, e il Losungen. (in inglese)

Lessici/Dizionari I lessici disponibili includono Codici
di Analisi Morfologica di Robinson,e
l'Enciclopedia della Bibbia Internazionale
Standard. I dizionari disponibili includono
il Dizionario Strong della Bibbia Ebraica,
il Dizionario Strong della Bibbia Greca,
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Introduzione

il Dizionario Rivisto e Non Abbreviato di
Webster della lingua inglese 1913, Bibbia
Attuale di Nave.

There are several other repositories that BibleTime will load and use.

Motivazione
Il nostro desiderio è servire Dio, e fare la nostra parte per aiutare gli altri a crescere nel loro rapporto con
Lui. Abbiamo cercato di rendere questo un programma potente, e di qualità, e ancora renderlo semplice e
intuitivo da utilizzare. È nostro desiderio che Dio sia lodato, poiché Egli è la fonte di tutte le cose buone.

Ogni buon regalo e ogni dono perfetto viene dall'alto e discende dal Padre della luce,
nel quale non c'è variazione né ombra di cambiamento.

—Giacomo 1:17, CEI

Dio ti benedica poiché usi questo programma.
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Chapter 2. Avviando BibleTime
Come avviare BibleTime

Avviando BibleTime
BibleTime è un file eseguibile integrato con il desktop. Puoi lanciare BibleTime dal menu di avvio con
questa icona:

BibleTime può anche essere avviato da un prompt dei comandi. Per lanciare BibleTime, apri una finestra
di terminale e digita:

bibletime

Personalizzazione avvio
Da terminale puoi utilizzare BibleTime per aprire versetti a caso nella Bibbia di default:

bibletime --open-default-bible "<random>"

Per aprire ad un certo passo come Gv 3,16 usa:

bibletime --open-default-bible "Giovanni 3:16"

Puoi anche utilizzare nomi di libri nel linguaggio corrente dei nomi dei libri.

Avviando BibleTime per la prima volta
Se è la prima volta che avvii BibleTime, vorrai configurare le seguenti opzioni, disponibili tra le
Impostazioni barra dei menu.

Gestore Libreria Modifies your Bookshelf. This dialog lets
you modify your Bookshelf, add or delete
works from your system. It will only be
shown if no default Bookshelf can be found.
Please see The Bookshelf Manager section
for further details. If you start off with an
empty Bookshelf, it will be helpful to install
at least one Bible, Commentary, Lexicon
and one Book to get to know BibleTime's
basic features quickly. You will be presented
with a list of works that are available
from the Crosswire Bible Society and other
repositories;

Configura BibleTime Personalizza BibleTime. Questa finestra ti
permette di adattare BibleTime alle tue
esigenze. Guarda la descrizione dettagliata di
questa finestra.
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Chapter 3. Funzionamento Programma
Panoramica del Programma

Ecco come una tipica sessione di BibleTime si presenta:

Puoi facilmente vedere le diverse parti dell'applicazione. La finestra in alto a sinistra è utilizzata per aprire i
documenti installati nella scheda della Libreria, e con la scheda dei Segnalibri puoi gestire i tuoi segnalibri.
La piccola finestra della "Lente" sotto la Libreria è utilizzata per visualizzare informazioni aggiuntive
inserite nei documenti. Quando muovi il mouse sopra una nota, per esempio, la Lente visualizzerà il
contenuto della nota. La barra degli strumenti ti dà accesso veloce alle funzioni importanti, e la Scrivania
sul lato destro è dove svolgi il tuo vero lavoro.

Procediamo a guardare alle diverse parti dell'applicazione individualmente.

Parti della finestra di applicazione BibleTime

La Libreria
La Libreria elenca tutti i documenti installati, ordinati per categoria e lingua. Ha anche una categoria
chiamata "Segnalibri". Qui è dove puoi salvare e accedere ai tuoi segnalibri.

Opening works

To open a work from the bookshelf for reading, simply double-click with the left mouse button on
the desired category (Bibles, Commentaries, Lexicons, Books, Devotionals or Glossaries) to display its
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Funzionamento Programma

contents. Then just double-click on one of the works to open it for reading. A read window will appear
in the Desk area.

Se stai leggendo un certo documento, e vuoi aprire un altro documento al passaggio che stai leggendo,
puoi usare una scorciatoia. Clicca con il pulsante sinistro del mouse sul versetto/passaggio di riferimento
(il puntatore diventa una mano) e trascinalo nella Libreria. Rilascialo sul documento che vuoi aprire, e
verrà aperto per la lettura nella posizione specificata. Puoi anche trascinare un versetto in una finestra di
lettura già esistente, salterà al passaggio specificato.

Informazioni aggiuntive sui documenti

Se clicchi con il pulsante destro del mouse sul simbolo di un documento, vedrai un menu con ulteriori voci
che sono rilevanti per questo documento. "About..." apre una finestra con tante informazioni interessanti
sul documento selezionato. "Sblocca..." apre una piccola finestra di dialogo per documenti cifrati, dove
puoi inserire la chiave di sblocco per accedere al documento. Per informazioni aggiuntive sui documenti
bloccati, per favore guarda  questa pagina [http://www.crosswire.org/sword/modules/aboutlocked.jsp] sul
sito di Crosswire Bible Society.

Cercare nei documenti

Puoi fare una ricerca in un documento cliccando con il pulsante destro del mouse sul suo simbolo e
selezionando "Cerca nei documenti". Premendo Shift e cliccando su altri documenti puoi selezionarne più
di uno. Poi segui la stessa procedura per aprire la finestra di ricerca. Cercherai in tutti quei documenti. Una
descrizione completa dell'operazione di ricerca può essere trovata nella sezione Cercare nei documenti.

Lavorare con i segnalibri

Tip

Trascina e Rilascia Documenti Qui
Clicca con il pulsante destro del mouse sulla categoria del segnalibro e seleziona "Crea nuova cartella" per
creare una nuova sotto-cartella di segnalibri. Puoi usare la normale funzione di drag & drop per trascinare
dai riferimenti di un versetto dalla finestra di lettura o dai risultati di ricerca alla cartella dei segnalibri, e
riorganizzare i segnalibri tra le cartelle.

Puoi anche importare segnalibri da altre persone o esportare segnalibri per condividerli con loro. Per far
questo, apri il menu contestuale della cartella dei segnalibri come descritto sopra, e seleziona "Esporta
segnalibri". Si aprirà una finestra di dialogo per salvare la collezione di segnalibri. Puoi importare i
segnalibri in modo simile.

Puoi anche cliccare con il pulsante destro del mouse su cartelle e segnalibri per cambiare i loro nomi e
descrizioni.

La Lente
Questa finestra nell'angolo in basso a sinistra della finestra di BibleTime è passiva. Ogni volta che il cursore
del mouse si trova su un testo con ulteriori informazioni (es. i numeri Strong), le informazioni aggiuntive
saranno visualizzate nella Lente, e non nel testo stesso. Provala.

La Scrivania
La Scrivania è dove viene fatto il vero lavoro con BibleTime. Qui puoi aprire documenti dalla Libreria,
leggerli, cercare in essi, e anche salvare le tue annotazioni nel modulo dei commenti personali (vedi  sotto).
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Funzionamento Programma

Lettura documenti

Come abbiamo già visto, puoi aprire documenti per leggerli semplicemente cliccando sul loro simbolo
nella Libreria. Una finestra di lettura di aprirà nella Scrivania. Ogni finestra di lettura ha una barra degli
strumenti. Lì puoi trovare gli strumenti per navigare nel documento che è collegato alla finestra di lettura,
come i pulsanti "cronologici" (per andare avanti e indietro) nei browser.

Auto Scrolling

The currently active window can be auto scrolled up or down. Start scrolling by press Shift+Down. You
can increase the scrolling speed by pressing Shift+Down multiple times. To pause scrolling press Space.
To start scrolling again at the previous speed press Space again. To slow down scrolling or scroll the other
direction press Shift+Up one or more times. Pressing any other key or changing the active window will
stop the scrolling.

Posizionamento finestra di lettura

Ovviamente puoi aprire più documenti allo stesso momento. Ci sono diverse possibilità per disporre le
finestre di lettura nella scrivania. Per favore dai una occhiata alla voce Finestra nel menu principale. Lì puoi
vedere che puoi controllare la disposizione delle finestre manualmente, o lasciare che BibleTime gestisca
la disposizione automatica. Per ottenere questo, devi selezionare una delle modalità di posizionamento
automatico disponibile alla voce Finestra → Arrangiamento. Provalo, è semplice e funziona.

Modificare i tuoi commenti

Per poter salvare i tuoi commenti su parti della Bibbia, devi installare un particolare documento dalla
libreria di Crosswire Bible Society [http://www.crosswire.org]. Questo documento si chiama "Commenti
personali".

Open the personal commentary by clicking on its symbol in the Bookshelf with a left mouse button. You
can edit this commentary by just clicking on any verse. A dialog opens which allows you to add or edit
text for that verse.

Tip

Se Modifica documento è disattivato, controlla di avere permessi di scrittura per i file dei
commenti personali.

Tip

Drag & drop documenti qui. Rilascia un riferimento ad un versetto e il testo del versetto sarà
inserito.

Cercare nei documenti

Cercare testo in una finestra di lettura aperta
Puoi cercare una parola o frase nella finestra di lettura aperta (es. il capitolo della Bibbia che stai leggendo)
come sei abituato in altri programmi. Questa funzione può essere ottenuta sia cliccando con il pulsante
destro del mouse e selezionando Cerca..., sia usando la scorciatoia CtrlF. Continua a leggere per sapere
come è possibile cercare nei documenti.
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Funzionamento Programma

Accesso alla finestra di ricerca
Puoi cercare in un documento cliccando con il pulsante destro del mouse sul suo simbolo nella Libreria
e selezionando Cerca nel documento. Tenendo premuto Shift o Ctrl e cliccando sul nome di un altro
documento puoi selezionarne più di uno. Poi segui la stessa procedura per aprire la finestra di ricerca.
Cercherai in tutti questi documenti allo stesso tempo.

Puoi anche accedere alla finestra di ricerca cliccando su Cerca dal menu principale, e selezionando la voce
appropriata.

Una terza possibilità per iniziare le ricerche è cliccare sul simbolo di ricerca in una finestra di lettura aperta.

Configurazione ricerca

Selezione documenti

In cima alla scheda delle opzioni troverai Scegli (documenti). Se volessi cercare in più documenti, clicca
su questo pulsante e apparirà un menu in cui scegliere i documenti in cui cercare.

Usare Filtri di Ricerca

Puoi restringere l'ambito della ricerca ad alcune parti della Bibbia selezionando uno dei filtri predefiniti
nella lista Ambiti di ricerca. Puoi definire i campi di ricerca, cliccando sul pulsante Setup Ambiti di Ricerca.
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Funzionamento Programma

Introduzione di Base alla Sintassi di Ricerca

Inserisci la frase di ricerca separata da spazi. Di default la funzione di ricerca restituirà i risultati che
soddisfano tutte le parole. Se vuoi trovare una qualsiasi delle parole inserite, seleziona il pulsante Alcune
parole. Se vuoi effettuare una ricerca più complessa, seleziona il pulsante Libero . Puoi vedere esempi di
ricerche cliccando su sintassi completa.

You can use wildcards: '*' matches any number of characters, while '?' will match any single character.
The use of parenthesis allows you to group your search terms, e.g. '(Jesus OR spirit) AND God'.

Per cercare un altro testo rispetto al testo principale, inserisci il tipo di testo seguito da ':' e dal termine di
ricerca. Fare riferimento alla tabella riportata di seguito per gli esempi.

Tipi di testo disponibili:

Table 3.1. Tipi di Ricerca

Prefisso Significato Esempio

heading: ricerca intestazioni heading:Gesù

footnote: ricerca note footnote:Mosè

strong: cerca Numeri Strong strong:G535

morph: cerca codici morfologici morph:N-GSM

Tip

Puoi cliccare di destro su un documento installato e selezionare About per trovare quali criteri
di ricerca di prima può funzionare. Non tutti i documenti hanno le caratteristiche per eseguire
questo tipo di ricerca.

BibleTime usa il motore di ricerca Lucene per effettuare le ricerche. Ha tante caratteristiche avanzate,
e puoi leggere di più qui:  http://lucene.apache.org/java/docs/index.html [http://lucene.apache.org/java/
docs/index.html].

Risultati di ricerca
Qui puoi vedere quante istanze della stringa di ricerca sono state trovate, ordinateper documento. Cliccando
su un lavoro con il pulsante destro del mouse puoi copiare, salvare o stampare tutti i versetti che sono
stati trovati in uncerto documento in una sola volta. Questo funziona anche quando clicchi su uno o più
deiriferimenti da copiare, salvare o stampare. Cliccando su un particolare riferimento siapre quel versetto
nel contesto nella finestra di anteprima qui sotto.

Tip

Trascina un riferimento e rilascialo sul simbolo di un documento nella Libreria per aprire il
documento a quel versetto in una nuova finestra di lettura.

Tip

Trascina un riferimento e rilascialo in una finestra di lettura, e salterà a quel versetto.

Tip

Seleziona riferimenti e trascinali nella Libreria per creare segnalibri.
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Funzionamento Programma

Analisi dei risultati di ricerca

Clicca su Analisi ricerca per visualizzare l'analisi di ricerca. Questo dà una semplice analisi grafica del
numero di istanze della stringa di ricerca trovate in ogni libro della Bibbia, ed è anche possibile salvare
l'analisi.

Il Gestore Libreria
Il Gestore Libreria è uno strumento per gestire la tua Libreria. Puoi installare nuovi documenti nella
tua Libreria, e aggiornare o rimuovere documenti esistenti dalla Libreria. Puoi accedervi cliccando
Impostazioni → Gestore Libreria nel menu principale.

Install works

With this facility, you can connect to a repository of works (called "library"), and transfer one or more
works to your local Bookshelf. These libraries may be local (e.g. a SWORD CD), or remote (e.g.
Crosswire's online repository of SWORD modules, or another site offering SWORD modules). BibleTime
will automatically maintain a list of remote libraries and the works available from them.

To begin the installation process, select one or more libraries that you want to install works from. Then
click on the Next button. Then select one or more languages and click the Next button. You will see a list
of categories. Double-click on a category to see works for that category. Select one or more works and
then click on the Install Works. After the works are installed, click on the Finish.

Update works

If there are any works that can be updated, they will be shown. Select one or more work and click the
Update Works. After the works are updated, click on the Finish.
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Funzionamento Programma

Remove works
This facility allows you to delete one or more of the works from your Bookshelf too free up disk space.
Simply choose the works` and click on the Remove works button.

Esportazione e Stampa
In molti posti, puoi aprire un menu contestuale cliccando con il pulsante destro del mouse. A seconda
del contesto potrai scegliere Seleziona, Copia (negli appunti), Salva o Stampa testo. Questo funziona per
esempio nella finestra di lettura, quando clicchi sul testo o sul riferimento al versetto, o nella pagina dei
risultati di ricerca quando clicchi su un documento o uno o più riferimenti ai versetti. È piuttosto semplice,
quindi basta provarlo.

Stampare da BibleTime è abbastanza basilare ed è una utility. Se stai componendo un documento o una
presentazione contenente testo di documenti di BibleTime, ti suggeriamo di usare uno degli editor di
presentazioni sul tuo sistema per formattare i tuoi documenti, piuttosto che stamparli direttamente da
BibleTime.
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Chapter 4. Configurando BibleTime
In questa sezione trovi una panoramica per configurare BibleTime, che può essere trovata sotto
Impostazioni nel menu principale.

Configura BibleTime
L'interfaccia utente di BibleTime può essere personalizzata in tanti modi a seconda delle tue esigenze.
Puoi accedere alla finestra di configurazione selezionando Impostazioni Configura BibleTime.

Visualizzazione

Il comportamento all'avvio può essere personalizzato. Seleziona tra le seguenti opzioni:

• Mostra il logo di avvio

I modelli di visualizzazione definiscono il rendering del testo (colore, dimensione, etc.). Sono disponibili
vari modelli. Se ne selezioni uno, vedrai un'anteprima nel pannello di destra.

Scrivania

Molte caratteristiche fornite dal SWORD backend possono essere personalizzate in BibleTime. Queste
caratteristiche sono documentate nella finestra. Hai anche la possibilità di specificare documenti standard
che dovranno essere usati quando nessun documento è specificato in un riferimento. Un esempio: La Bibbia
standard è usata per visualizzare il contenuto dei riferimenti incrociati nella Bibbia. Quando ci passi il
mouse sopra, la Lente mostrerà il contenuto dei versetti a cui si riferiscono, secondo la Bibbia standard
specificata. Con l'uso di filtri del testo, puoi controllare l'aspetto del testo.

Lingue

Qui puoi specificare che lingua deve essere usata per i nomi dei libri della Bibbia. Imposta la tua lingua
nativa, se è disponibile, e ti sentirai a casa.

Di default, BibleTime usa i caratteri di sistema. Puoi cambiare questo carattere se necessario. Alcune
lingue richiedono caratteri speciali per essere visualizzate correttamente, e questa finestra ti permette di
specificare un carattere personalizzato per ogni lingua.
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Configurando BibleTime

La Finestra Opzioni - Caratteri.

BibleTime può usare tutti i caratteri supportati. Finché i documenti che ti interessano sono visualizzati
correttamente qui nulla deve essere fatto. Se un documento è visualizzato solo come una serie di punti
interrogativi (??????) o scatole vuote, allora sai che il carattere di visualizzazione standard non contiene
i caratteri usati in questo documento.

Per correggere, scegli la lingua di questo documento dal menu a tendina. Seleziona l'uso di caratteri
personalizzati nel checkbox. Poi seleziona un carattere. Per esempio, un carattere che supporta molte lingue
è Code2000. Se nessun font installato può visualizzare il documento che ti interessa, prova ad installare
il pacchetto di localizzazione per quella lingua.

Installazione caratteri

L'installazione dettagliata dei caratteri esula dallo scopo di questo manuale. Per maggiori informazioni
puoi riferirti all'  Unicode HOWTO [http://www.linux.org/docs/ldp/howto/Unicode-HOWTO-2.html].

Fonts can be installed from a number of sources:

• La tua distribuzione *nix.

• I pacchetti di localizzazione della tua distribuzione.

• Un'esistente installazione di Microsoft Windows® sullo stesso computer.

• Una collezione di caratteri, sono disponibili da Adobe o Bitstream.
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Configurando BibleTime

• Collezioni di caratteri online.

I caratteri Unicode supportano più caratteri degli altri, e alcuni di questi sono disponibili gratuitamente.
Nessuno dei caratteri disponibili include tutti i caratteri definiti nello standard Unicode, quindi potresti
voler usare diversi caratteri per diverse lingue.

Table 4.1. Caratteri Unicode

Code2000 [http://code2000.net/CODE2000.ZIP] Forse il miglior carattere Unicode, che copre una
vasta gamma di caratteri.

SIL caratteri unicode [http://scripts.sil.org/cms/
scripts/page.php?
site_id=nrsi&cat_id=FontDownloads]

Eccellenti caratteri Unicode dal Summer Institute of
Linguistics.

FreeFont [http://www.nongnu.org/freefont/] Una nuova iniziativa di caratteri Unicode liberi.

caratteri di Crosswire [ftp://ftp.crosswire.org/pub/
sword/iso/latest/FONTS/]

Diversi caratteri disponibili dal sito ftp di Crosswire
Bible Society.

Bitstream CyberBit [http://aol-4.vo.llnwd.net/pub/
communicator/extras/fonts/windows/]

Copre quasi l'intera gamma di Unicode, ma potrebbe
rallentare BibleTime a causa delle sue dimensioni.

Clearlyu Incluso in alcune distribuzioni. Contiene Europeo,
Greco, Ebraico, Thai.

Caslon, Monospace, Cupola, Caliban [http://
fontforge.sourceforge.net/sfds/]

Copertura parziale, guarda le informazioni sul sito
linkato.

Ci sono buone liste di caratteri Unicode in rete, come una di Christoph Singer ( Caratteri multilingua
Unicode TrueType in Internet [http://www.slovo.info/unifonts.htm]), o quella di Alan Wood (  Gamme
di caratteri Unicode e i caratteri Unicode che le supportano [http://www.alanwood.net/unicode/
fontsbyrange.html]).

Scorciatoie

Le scorciatoie sono speciali comandi da tastiera che possono essere usati al posto dei menu e delle icone.
Un certo numero di comandi di BibleTime hanno scorciatoie predefinite (vedi questa sezione per una lista
completa). Alla maggior parte dei comandi di BibleTime può essere assegnata una scorciatoia. Molto utile
per accedere alle funzioni che usi maggiormente.
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Configurando BibleTime

Nell'esempio precedente, F2, l'HowTo per lo studio della Bibbia ha una scorciatoia secondaria definita,
CTRL+2.
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Chapter 5. Riferimento
Riferimento Menu Principale

In questa sezione è puoi trovare descrizioni dettagliate di tutte le voci del menu principale di BibleTime.
Sono ordinate nell'ordine in cui appaiono in BibleTime, con tutti i sotto-elementi elencati sotto la voce
principale del menu a cui appartengono. Puoi anche vedere la scorciatoia di ogni elemento, una lista
completa di tutte le scorciatoie la trovi nella sezione scorciatoie.

File

File 

→

 Apri documento

Apri documento. Si aprirà un menu che ti
permetterà di aprire i libri installati.

File 

→

 Esci (Ctrl+Q)

Chiudi BibleTime. BibleTime ti chiederà se
vuoi scrivere i cambiamenti non salvati sul
disco.

Vista

Visualizza 

→

 Schermo intero (F5)

Attiva/disattiva fullscreen. Usa questa
impostazione per modificare la modalità
fullscreen di BibleTime.

Vedi 

→

 Mostra Libreria

Mostra/nascondi Libreria. Cambia questa
impostazione per mostrare o nascodere la
Libreria nel pannello di sinistra. Può essere
utile se hai bisogno di di più spazio per la
Lente.

Vedi 

→

 Mostra Segnalibri

Mostra/nascondi Segnalibri. Cambia questa
impostazione per mostrare o nascodere la
Segnalibri nel pannello di sinistra. Può essere
utile se hai bisogno di di più spazio per la
Lente.

Mostra 

→

 Mostra Info

Mostra/nascondi Lente. Cambia questa
impostazione per mostrare o nascodere la
Lente nel pannello di sinistra.

Mostra 

→

 Mostra intestazioni testi paralleli

Mostr opere aggiuntive Attiva questa
impostazione per mostrare altre opere in
parallelo con i libri attualmente aperti.

Visualizza → Barre degli strumenti → Mostra barra
principale (F6)

Mostra/nascondi barra degli strumenti
principale. Cambia questa impostazione
per mostrare o nascondere la barra degli
strumenti principale.

Visualizza → Barre degli strumenti → Mostra barra di
navigazione

Mostra/nascondi Navigazione nei documenti.
Cambia questa impostazione per mostrare
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Riferimento

o nascondere la navigazione nei documenti.
Può essere comodo per vedere la barra degli
strumenti completa per i documenti aperti.

Visualizza → Barre degli strumenti → Mostra barra dei
documenti

Mostra/nascondi barra degli strumenti nei
documenti. Cambia questa impostazione per
mostrare o nascondere l'icona dei documenti
nei documenti aperti.

Visualizza → Barre degli strumenti → Mostra barra
degli strumenti

Mostra/nascondi strumenti nei documenti.
Cambia questa impostazione per mostrare
o nascondere le icone degli strumenti nei
documenti aperti.

Visualizza → Barre degli strumenti → Mostra barra di
formattazione

Mostra/nascondi formattazione. Cambia
questa impostazione quando modifichi del
HTML nei Commenti Personali. Mostrerà o
nasconderà la barra della formattazione.

Visualizza → Barre degli strumenti → Mostra barre
degli strumenti nelle finestre di testo

Mostra/nascondi barre degli strumenti nei
documenti. Cambia questa impostazione per
mostrare o nascondere l'intera barra degli
strumenti nei documenti aperti.

Cerca

Cerca 

→

 Cerca nellaBibbia standard (Ctrl+Alt
+F)

Apre la finestra di Ricerca per cercare solo
nella Bibbia standard. Più documenti possono
essere aggiunti della finestra di ricerca. Una
descrizione più dettagliata della ricerca la
trovi nella sezione Cercare nei documenti.

Cerca 

→

 Cerca neidocumenti aperti (Ctrl+O)

Apre la finestra di Ricerca per cercare in tutti i
documenti aperti. I documenti possono essere
aggiunti o rimosssi della finestra di ricerca.
Una descrizione più dettagliata della ricerca
la trovi nella sezione Cercare nei documenti.

Finestra

Finestra 

→

 Chiudi finestra (Ctrl+W)

Chiudi finestra attiva.

Finestra 

→

 Chiudi tutte (Ctrl+Alt+W)

Chiudi tutte le finestre aperte.

Finestra 

→

 Cascata (Ctrl+J)

Metti in cascata tutte le finestre aperte.

Finestra 

→

 Affianca (Ctrl+I)

Dispone tutte le finestre aperte.
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Riferimento

Finestra 

→

 Affiancaverticalmente (Ctrl+G)

Disposizione verticale automatica delle
finestre aperte.

Finestra 

→

 Affiancaorizzontalmente (Ctrl+H)

Disposizione orizzontale automatica delle
finestre aperte.

Finestra → Arrangiamento Controlla il comportamento base della
disposizione delle finestre. Nel menu
contestuale, puoi specificare se vuoi gestire
tu la disposizione delle finestre (modalità
Manuale), Schede, Affianca verticalmente,
Affianca orizzontalmente, Auto-affianca o In
cascata. Dacci un'occhiata!

Finestra → Salva sessione Salva direttamente la sessione corrente.
Si aprirà un menu contestuale dove puoi
selezionare una sessione esistente per
salvarla. Verrà sovrascritta con la sessione
corrente. Vedi il prossimo elemento su come
salvare in una nuova sessione.

Finestra → Salvacome nuova sessione (Ctrl+Alt+S) Salva la sessione corrente sotto nuovo nome.
Ti chiederà un nuovo nome per salvare la
sessione.

Finestra → Carica sessione Carica una sessione esistente. Si aprirà un
menu contestuale dove potrai selezionare una
sessione esistente da caricare.

Finestra → Elimina sessione Cancella una sessione esistente. Si aprirà un
menu contestuale dove potrai selezionare una
sessione esistente da cancellare.

Impostazioni

Impostazioni 

→

 Configura BibleTime

Apre la finestra di configurazione di
BibleTime. Puoi configurare tutti i tipi di
impostazioni per adattare BibleTime alle
tue esigenze. Guarda la sezione Configurare
BibleTime per maggiori dettagli.

Impostazioni 

→

 Gestore Libreria (F4)

Apre una finestra dove puoi cambiare la
configurazione di SWORD e gestire la tua
libreria. Guarda la sezione  Gestore Libreria
per maggiori dettagli.

Aiuto

Aiuto 

→

 Manuale (F1)

Apre la guida utente di BibleTime La stai
leggendo adesso.
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Aiuto 

→

 HowTo Studio Bibbia (F2)

Apre una guida su come studiare la Bibbia
La speranza del team BibleTime è che
questo HowTo provochi i lettori a studiare
le scritture per vedere cosa dicono. Questa
guida particolare è stata scelta perché si cura
di non sostenere una dottrina in particolare.
Ci aspettiamo che tu legga e studi le
scritture per capire cosa dicono. Se inizi con
l'atteggiamento di chi desidera che il Signore
semini la sua parola nel proprio cuore, Lui
non ti deluderà.

Aiuto 

→

 Suggerimento del giorno (F3)

Apre un suggerimento utile Il suggerimento
del giorno fornisce un utile suggerimento che
ti assisterà nell'utilizzo di BibleTime.

Aiuto → About BibleTime Apre una finestra di informazioni sul
progetto BibleTime contiene informazioni
sulla versione di BibleTime, sui contributori
del progetto, la versione di SWORD, la
versione delle Qt e l'accordo di licenza.

Riferimento documenti
In questa sezione puoi trovare la descrizione delle icone associate con i documenti aperti.

Scorre in avanti nella cronologia.

Scorre indietro nella cronologia.

Seleziona una bibbia installata.

Seleziona una bibbia aggiuntiva.

Cerca nel documenti selezionati.

Configurazione visualizzazione.

Seleziona un commento installato.

18



Riferimento

Seleziona un commento aggiuntivo.

Sincronizza la voce visualizzata con la
finestra della Bibbia attiva.

Seleziona un libro.

Selezionare un glossario installato o una
lettura devozionale.

Selezionare un glossario o una lettura
devozionale aggiuntivo.

Indice scorciatoie
Questo è un indice di tutte le scorciatoie e delle loro descrizioni corrispondenti nel manuale. Le scorciatoie
sono disposte in ordine alfabetico. Se vuoi trovare direttamente quale scorciatoie un certo elemento del
menu ha, puoi guardare all'elemento stesso in BibleTime (che mostra sempre la scorciatoia), o puoi
guardare nel Riferimento Menu Principale.

Scorciatoia Descrizione

Alt+Left Vai indietro nella cronologia della finestra di lettura.

Alt+Right Vai avanti nella cronologia della finestra di lettura.

Ctrl+Alt+F Cerca → Cerca nella Bibbia di default  equivalent;
apre la finestra per cercare nella Bibbia di default.

Ctrl+Alt+G Finestra → Arrangiamento → Disponi
verticalmente automaticamente equivalent; attiva/
disattiva la disposizione automatica delle finestre.

Ctrl+Alt+H Finestra → Arrangiamento → Disponi
orizzotalmente automaticamente equivalent; attiva/
disattiva la disposizione automatica delle finestre.

Ctrl+Alt+I Finestra → Arrangiamento → Disponi
verticalmente automaticamente equivalent; attiva/
disattiva la disposizione automatica delle finestre.

Ctrl+Alt+J Finestra → Arrangiamento → In cascata
automaticamente equivalent; attiva/disattiva la
cascata automatica delle finestre.

Ctrl+Alt+M Finestra → Arrangiamento → Modalità manuale
equivalent; attiva/disattiva la modalità manuale del
piazzamento delle finestre.

Ctrl+Alt+T Finestra → Arrangiamento → Schede equivalent;
organizza le finestra in schede in alto.
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Scorciatoia Descrizione

Ctrl+Alt+S Finestra → Salva come nuova sessione  equivalent;
salva layout corrente come nuova sessione.

Ctrl+Alt+W Finestra → Chiudi tutte  equivalent; chiude tutte le
finestre aperte.

Ctrl+A Seleziona tutto. Seleziona tutto il testo nella finestra
di lettura.

Ctrl+C Copia. Copia il testo selezionato negli appunti.

Ctrl+F Cerca. Ti permette di cercare nel testo della finestra
di lettura.

Ctrl+G Finestra → Disponi verticalmente  equivalent.

Ctrl+H Finestra → Disponi orizzontalmente  equivalent.

Ctrl+I Finestra → Cascata  finestre equivalent.

Ctrl+J Finestra → Cascata  finestre equivalent.

Ctrl+L Cambia posizione. Modifica focus al campo della
barra degli strumenti per il lavoro selezionato.

Ctrl+N Cerca nei documenti di questa finestra.

Ctrl+O Cerca → Cerca nei documenti aperti  equivalent;
apre la finestra di ricerca per cercare in tutti i
documenti aperti.

Ctrl+Q File → Esci  equivalent; chiude BibleTime.

Ctrl+W Chiude la finestra corrente.

F1 Aiuto → Manuale equivalent; apre il manuale.

F2 Aiuto → HowTo Studio Bibbia equivalent; apre
l'HowTo per lo studio della Bibbia.

F3 Aiuto → Suggerimento del giornoApre un utile
suggerimento per usare BibleTime.

F4 Impostazioni → Gestore Libreria  equivalent; apre
il Gestore Libreria.

F8 Visualizza → Mostra Libreria  equivalent; attiva/
disattiva visualizzazione della Libreria.

F9 Visualizza → Mostra lente  equivalent; attiva/
disattiva visualizzazione della lente.

Shift+Down View → Auto scroll down

Shift+Up View → Auto scroll up

Space View → Auto scroll pause

20


